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Introduction 

Thank you for choosing WINLIVE by Promusicsoftware, the first musical repertoire management 
program with specific Karaoke features, whose first version dates back to  November 6th, 1994. 
The intention of its founder, Leonardo Di Pinto was to create a program that could work with 
different file formats then to manage them in a simple and immediate way. WINLIVE PRO SYNTH 
11 version, available for both Mac OSx and Windows, is designed for a professional use. Thanks to 
its last update, it is particularly appreciated by singer-performers, who require a reliable program 
to manage their own musical repertoire, compatible and adaptable to their proper tools in order 
to look like being on stage.   
Karaoke enthusiasts, who like to customize their performances, also appreciate it very much. 
PRO SYNTH is WINLIVE’s commercial version, therefore third parts assignment, unlawful copy of 
the license and any other copyright piracy action concerning the software are forbidden. 
Reverse Engineering implementation, code and graphic resources editing as well as reproducing all 
files even partially are forbidden and open to legal prosecution. We decline any responsibility from 
using the software improperly and/or damaging the operating system as well as losing data. 

  
To know more, visit our website: 

 www.promusicsoftware.com 

 

WINLIVE is a Pro Music Software brand 
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INSTALLATION AND REQUIREMENTS 
To install WINLIVE just run the setup and then follow the instructions on the screen. Normally, at 
the end of the installation, the software requires the entry of your PERSONAL ACCOUNT and the 
SERIAL NUMBER, which can be found in your e-mail (if the software was bought online) or in the 
package of the software (if bought in store). You can choose the demonstrative mode, in case you 
do not have the license, in order to discover all Winlive features. DEMO version has a limited use 
(it can only manage 20 songs) and its public use is expressly prohibited. FULL version has no 
restrictions.  
Internet connection is necessary to activate the software. When the computer is connected to the 
internet, you can simply entry PERSONAL ACCOUNT, SERIAL NUMBER, and all required data. 
When an ID COMPUTER appear, you just need to click on ACTIVATE YOUR COPY HERE. 
 If your computer is not connected to the internet, you should install software setup, then insert 
PERSONAL ACCOUNT, SERIAL NUMBER, and all required data. At this point, an ID COMPUTER will 
appear. From any device connected to the internet, connect to our website: 
www.promusicsoftware.com 
Go to Activations insert PERSONAL ACCOUNT and SERIAL NUMBER to log in your personal 
account. Click on NEW ACTIVATION, so insert the ID COMPUTER generated by the program. Then 
a license number will appear. Copy it and paste it in the blank line as required by the program. 
 
120 minutes of FREE REMOTE ASSISTANCE (WINLIVE PRO 11/PRO SYNTH 10 version users only) and 
YOUTUBE SERVICE are guaranteed until February 2022. 
 

Watch the video tutorial to learn more about the installation of the software 

https://youtu.be/KY4lNKBAdAk 

 

* System requirements recommended for Windows: Ram 2Gb, 200 Mb Free space on Hard Drive, CPU i3 or better 
* System requirements recommended for Mac: Ram 3Gb, 1200 Mb Free space on Hard Drive, CPU i3 or better 

* Compatible with Windows 7, Windows 8/8.1 and Windows 10, 32 bit or 64 bit 
* Compatible with Mac osX (tested from High Sierra to Big Sur) 

 

Note: the recommended system requirements grant the functioning of the software and the execution of the songs by 
the program but it could be necessary to deactivate all graphic effects to get a better performance, which could 
decline substantially during the reproduction of CDG or VIDEO files. 

The software could work with older versions of Windows but correct functioning is not granted. 
* Without the recommended system requirements, starting the program could result slower due to the swapping on 
the HD and the slowness of the processor. 
* Some antivirus could slower the initiation of the program. If the software stucks on start on “Check Antivirus” for a 
long time, deactivate the antivirus temporarily.  
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Functionalities 

WINLIVE PRO SYNTH is not just a Karaoke software but also a feature-rich music player and 
management program. WINLIVE PRO SYNTH provides a real-time playback management. 
Synchronized lyrics and chords contained in the files are easy to see and read. It is also possible to 
synchronize lyrics and chords on empty files or on files that do not provide them at first. WINLIVE 
PRO SYNTH manages up to 42 playlists, named SONGLIST, of which 39 in Database, 1 temporary 
(F10) and 2 Song Folder List (F11 and F12 for external loadings outside of the database). It is 
possible to act on different parameters of a music file: you can start and stop it at any time, 
change the rhythm, the tone (any format audio and video), the instruments, the volume, the pan, 
etc.… till the single drum notes, everything in real time! 
Great improvement in the listening of Midifiles is provided by our Synthesizer software (Winlive 
Synth Orchestra) included in the program aiming to get obtain a real sound. 
Media Explorer mode is strengthened, in order to let you manage the files directly from HD or 
external drive, avoiding a prearranged database needed to import them. We mainly recommend 
this mode to those who enjoy Karaoke and manage dozens and dozens of files. 
 

We recommend to our users not to use illegal copies of the software, reminding 
not only that holding software without any number of registration is a criminal 
offence, but also that the same pirate software contain dangerous virus that can 
cause system crash.  
 
We remind, instead, to all our registered WINLIVE PRO SYNTH 11 users that they have access to 120 minutes of free 
remote assistance. Our operators can interface directly with the users to show them the countless features of Winlive.  
It is one of the most appreciated services by our users. We remind that remote assistance, as YouTube services are 
dedicated exclusively to those who own the last updated version, it is not provided for the previous versions. We 
reaffirm that FREE REMOTE ASSISTANCE (120 minutes) and YOUTUBE SERVICES are active for this version until the 
end of FEBRUARY 2022. It is recommended, however, to upload the latest version to keep ‘’up’’ with the continuous 
innovations of Winlive. 
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Main features of WINLIVE PRO SYNTH 11 
(The ones in bold are the new features compared to the previous version) 

 
PLAYER section 
Playing of various media files (midi, kar, mp3, mp3+lrc, wav, cdg, cdg.zip, wmt, avi, mpg, mp4, flv, wma, txt, rtf, jpg, 
gif, bmp, ytb youtube, pdf) 
* Multitrack audio reading up to 16 tracks and creation of a single exclusive .wmt file (Winlive Multi Track) including 
any txt and pdf files 
* Saving separate tracks from midi to midi and from midi to audio (synth version) with the possibility to generate 
and save the metronome click 
* Key transpose for MIDI files, audio, audio multitracks and video 
* PAN assignment to audio outputs (ability to set outputs to L, R or L + R). Eg. it is possible to direct the backing 
track to the left channel and the drum click to the right channel 
* Ability to change audio output to individual midi synth channels (windows only) 
* Customize sound mapping 
Scrolling text (only for Windows version) 
Images as a moving background can be recalled randomly even from an image folder 
Media Explorer function for direct access to backing tracks without using the database 
Ultra fast search in Media Explorer even among hundreds of thousands of files 
Creation of customized lists with saving in the Media Explorer 
Management of 10 markers for each song 
* Selection of duplicate files with new dedicated functions 
Management of Youtube direct links within Winlive 
Graphic equalizer on the internal Synth 
Event editor to associate personal events to midi, audio and video files 
Ability to zoom PDF files for proper viewing on the monitor 
Quick icons programmable for an immediate access to other sections 
Audio mixing also with video files 
Import of VanBasco playlists with tonal parameters, silent channels, etc. 
Winlive DJ Control mode with BMP recognition for Audio files with real time effects application 
Metrodrummer (electronic drums with preset rhythms) and midifiles synchro possibility 
Midi remix style using a library containing more than 250 rhythms 
* New rhythms available 
Possibility to easily replace the rhythm to a midifile and save it in the database 
* Visual metronome 
Pan editor for audio and video files 
MPX function for audio files with tracks divided into left and right 
Background playlist with automatic start in moments of pause and setting of seconds to wait 
Recording of an Audio track on Midi and Audio with the possibility of creating a single audio file (e.g. record your voice 
on a backing track and save everything in audio) 
Preview the audio files on your secondary device (E.G. Headphones) 
Evolved mixing editor with max 5 different live time liable to recall monitors  
Bowith fade out or mixing between Audio song, Midi and video 
Effect insertion on main or secondary/recorded Audio tracks 
Possibility to match a midi file with an audio file or vice versa or two audio tracks 
Dual monitor support (karaoke monitor) for Video and CDG files too 
Clone monitor of main monitor or karaoke monitor 
Melody preview bar 
Integrated video codec repair / installation function 
Flowing subtitles management for karaoke monitor  
Database for managing files and related settings 
Automatic search for missing files 
Highlighting of missing file already in the songlist 
User sound editor for the creation of new sound banks 
User drumkit editor for new drumkits creation 
Audio Samples editor for real-time insertion up to 100 samples 
Managing Volume, Effects, timbre, resonance, Transpose, Sustain, etc .. for each midi track 
Storing virtual or physical changes for each song (midi and audio) 
Management of up to 16 different devices for midi 
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Import text in TXT, RTF, PDF format (electronic music-stand) 
Support for windows tablets in portrait mode (vertical) 
Various karaoke display methods, also different for secondary screen (Karaoke Monitor) 
Auto chord recognition from midi files 
Display chords on the text 
* Chord time bar 
Assignment of the melody to any midi channel (default midi channel 4) 
Possibility to edit the individual notes of the drum track 
Ability to associate a text, image or pdf to an Audio or Midi 
Insert your custom lyrics and chords for Midi and Audio (stored in meta tags of the media file) 
SongService (M-live) format compatibility 
MP3 reading with chords from SongService library (M-live) 
Other than chords, you'll be able to save other parameters (volume, key, equalization, Gain, MFx, etc...) 
Saving lyrics even in SYLT format 
Saving video files to audio files (wav,mp3) 
Wave to mp3 converter 
Sophisticated song search system with different criteria 
Extraction and conversion from Cd to mp3 or wave 
Volumes compressor for both Audio and Midi Files 
Lyrics and chords insertion for Midi and Mp3 
Images as background insertion 
Cover function to change the feeling of midifiles 
Grooves import in both midi and audio formats 
Cue point management with detailed info such as: insert text, images, loops, jumps key change at specific points ecc.. 
Simplified display of notes on staff for midifiles 
Display of notes on piano keyboard for educational use 
Possibility to merge more databases 
Many keyboard shortcuts and limited use of the mouse 
* WINLIVE REMOTE CONTROL app to remotely control the main Winlive functions (available in the next free 
updates) 
* Renew Youtube functions available only for WINLIVE 11 series versions 
* Dozens of new features suggested by our users 
* 120 minutes of free remote assistance (available only for WINLIVE PRO 11 and WINLIVE PRO SYNTH 11 versions) 
Intuitive, functional and performing 
 
SYNTH section (SYNTH ORCHESTRA) 
* New Internal GS/GM+ sound bank of 96 MB HI-Quality Wavetable (SFX sounds included) 
* Wavetable with 32 drum kits and 344 sounds  
* New and more and more performing sounds to increase the quality of your midifiles 
Implementation of low latency WASAPI drivers 
It is possible with low latency to play a midi keyboard directly linked to your computer 
Winlive digital piano, up to 4 part sound synthesizer 
ASIO Driver management 
Convert MIDI to Wave or Mp3 directly with karaoke and chords included 
Main volume, Compressor, filter enhancer on Midi Engine 
Delay effect management on every midi track 
Multi effect management on sounds from inner Synth with more than 20 selectable MFX on every midi track 
 
* Notes for Mac version: some functions on Mac computer may change or not exist compared with PC 

Windows version (mainly Scrolling text, combination of effects to sounds, YouTube tracks execution external to 
program) 
 

After the purchase, automatically, you will receive via email the activation codes.  
You can use up to 3 activations per license even on different computers 
For further activations please contact Promusicsoftware 

Note: if you replace or format the hard disk, an activation is lost 
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File 

Info: WINLIVE can perform its songs in various ways. 

1) We can play one or more songs by dragging them directly to the Performance screen. In this 
way, by dragging a single file we could listen immediately while for multiple songs a temporary 
Songlist will be created and then selecting the favorite song we could play it by pressing the enter 
key. 

2) We can load a single song from File menu and then Load File 

3) We can explore our songs on our hard disks by selecting Media Explorer from the File menu. 
This mode is ideal for those who want to play but with limited editing functions of the song. It is 
mainly used for Karaoke performances (see Media Explorer paragraph); 

4) The last way to perform our songs is to use the Database. This mode has made the Winlive 
famous all over the world and is mainly used by musicians, singers and bands. With this mode it is 
possible to save the many options that Winlive offers  (see Database paragraph); 
 
MULTI IMPORT IN DATABASE 
You can select the various songs to be imported into the Database (see Database paragraph); 
 
MEDIA EXPLORER 
A section opens where you can explore the songs on our hard disks (see Media Explorer 
paragraph); 
 
LOAD FILE 
It is possible to load a single song and play it immediately. 

 

SAVE FILE 
It is possible to save a single file in various ways (see Save File paragraph); 
 
GENERATE SONGBOOK 
A sheet is generated where the lyricst and any chords will be displayed (see Songbook paragraph); 
 
FOLDER 
Here you can load an entire folder of songs and associate it with special songlists that can be 
recalled with the F11 and F12 keys. This function is very useful, for example, when we want to 
view the contents of a USB key without loading it into our database 

 

LOAD SONG AUDIO MULTRACK 

This new function allows you to load and manage a multitrack audio track made up of multiple 
audio tracks (maximum 16). These tracks are enclosed in a folder.First we must open the folder 
and choose one of the audio tracks where we could possibly insert lyrics and chords. All other 
tracks will be loaded at the same time. Once the multitrack audio track has been loaded, a 
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horizontal mixer will open (visual mixer) where the various tracks will be displayed with the 
possibility of varying the volumes. 

 

 
Also we could decide which tracks can undergo tonal changes. Obviously the rhythmic tracks must 
not be transposed 
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We can optionally save the entire multi-track song thus edited in a single file called WMT (winlive 
multi track) click on FILE-> Create or edit WMT file.In addition we can associate a pdf or txt file (for 
example we can associate a pdf score to the song) 

 

At this point we could import it into the database and assign separate audio outputs if we have 
connected a multi-channel sound card to our PC. 

The separate audio outputs will be set in Tools-> Options-> Audio Options and by pressing the 
mixer button we could establish on which audio channel each track could output 

https://youtu.be/QoXKFH65T30?t=235 

 
LOAD LIST F10 
By clicking on this item it is possible to load those lists created in the temporary lists and recalled 
with the F10 key. Remember that the temporary lists are emptied every time you exit the 
program. 
 
SAVE LIST F10 
Here you can save temporary lists. 
 
IMPORT IN DATABASE 
If a song is loaded temporarily it is possible with this function to import it into the Database. 
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IMPORT IN DATABASE ALL F10 
With this function it is possible to import an entire temporary F10 songlist into the database. 
 
STOP AT THE END OF EACH SONG (Performance) 
This parameter sets the STOP at the end of the song even if a song has been booked 
 
STOP OF THE SONG EVEN IF BOOKED 
This parameter sets the STOP at the end of the song even if a song has been booked 
 
RANDOM NEXT SONG (Performance) 
It is possible to set a random execution of the songs of the current songlist 
 
MLIVE ENCODING PRECEDENCE INSTEAD OF KARAOKE 
Very often in a song there may be several lyrics, perhaps created with different programs. 
Enabling this function gives priority to the display of the MLIVE lyrics. MLIVE encoding is present in 
songservice songs 
 
AUTOMATICALLY LOCK THE KEYBOARD 
With this option the PC keyboard is locked. This function is very useful when you are away from 
the PC so as to avoid that someone touching the keyboard can compromise our performance 
 
MINIMIZE 
The WINLIVE program is minimized to display the PC desktop 
 
CLOSE 
The program closes. In this case some parameters and the database are automatically saved 
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View mode 

Through the menu View Mode, it is possible to choose the program’s operating mode: 
Performance [CTRL+ALT+P]: it is the playback mode used to control the various Song-List playlists 
on startup, as well as the disposal of the song booking, the control the performance, mixer and 
karaoke (see paragraph);  
Edit Mode [CTRL+ALT+E]: it is the mode used to edit different parameters of songs, lyrics, chords 
and Markers (see paragraph); 
Media Explorer [CTRL+ALT+M]: it is the mode used to explore hard disks and eventually execute 
files without inserting them in the Database (see paragraph); 
Visual Mixer [CTRL+S]: displays a mixer horizontally with which we can control the various tracks 
of the midifiles or of the audio multitrack songs 

 
Database [CTRL+ALT+D]: it the collection of songs, used to organize and catalogue them; 
The database stores the path of songs, their parameters, their changes and the insertion of any 
images as background, texts or pdf combined to every song (see paragraph); 
Winlive Digital Piano [CTRL+ALT+W]: virtual synth with 4 parts and appropriate sound card low-
latency, in order play in real time through an external musical keyboard (see paragraph); 
Metrodrummer [CTRL+ALT+B]:  electronic drum with more than 220 pre-set rhythms with the 
chance to sync with midifiles or like a real desk electronic drum (see paragraph); 
Winlive DJ Control [CTRL+ALT+J]: section with typical Djs mode with BPM recognition for Audio 
files, effects in real time and several tools available (see paragraph); 
YouTube Songs [CTRL+ALT+Y]: section where it is allowed to search for video files directly on 
YouTube and eventually include them on your SongList (comply with the terms of use of YouTube). 
This mode requires an internet connection (see paragraph); 
YouTube SongList [CTRL+ALT+L]: is a weekly uploaded section of links to YouTube tracks. An 
internet connection is required, as well as the acceptance of YouTube conditions (see paragraph); 
Events managment [CTRL+ALT+V]: this function allows you to insert some events, sounds or 
functions in combination to a midi, audio or video file. For example, it is possible to insert, in a 
specific point of the song, a key change, a picture or a pdf, a sample, a change of a pdf page and so 
on in order to customize your own musical performance (see paragraph). 
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KARAOKE MONITOR 
You can activate the second monitor (karaoke monitor) by clicking on the menu "View" -> 
"Karaoke Monitor" or  [CTRL+K] from the keyboard. 
A second Winlive window will open, which you can drag on the second monitor; double clicking on 
it will be set to full screen. 
By right clicking on the main monitor screen you can change the character and mode of the 
Karaoke Monitor, you can choose between: 
• Multiline scrolling karaoke (only Microsoft Windows); 
• Winlive Classic: 2 lines; 
• Modern Style: 4 lines; 
• Music Stand: 4 lines + 1; 
• Karaoke Zoom mode 
• No Karaoke 
 
Note: to make this function work correctly, from Windows imports, select the second monitor in 
Extended Desktop mode. Refer to the video card help manual. 
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CLONE MONITOR 
You can activate the clone monitor by clicking on the menu "View" -> "Clone Monitor" or  [CTRL+J] 
from the keyboard. 
By the clone monitor it is possible to clone the main monitor or the karaoke monitor so that it can 
be viewed on a possible third monitor. 

 
 
To change the display source in Clone Monitor click on Screen Selection 
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MELODY BAR 

It is activated and deactivated via the "View" menu -> Melody Bar or by pressing the MDB quick 
command or by using the letter key  [E]. We strongly recommend how we will reiterate the use of 
the PC keyboard keys instead of the mouse several times. With a single press the screen, like the 
one below, will be displayed, describing chords and melody notes. Obviously this only for 
midifiles

 
A second press allows you to view only the graphics of the trend and the timing of the melody 
(track 4 in the case of midi, based on the text in the case of the mp3), in order to help the singer to 
go to time with the song. This feature is highly appreciated especially for Karaoke performances. 
You can set the fixed or sliding melody bar (see chapter Options). 

If it were set fixed, the page change would take place in correspondence of the red line (generally 
every 40 seconds). 
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CHORD BAR 
It is activated through the menu "View mode" -> "Chord Bar" or by pressing the Quick Icon CHD or 
through the letter key  [C]. View the chords (if any), scrolling them simultaneously with the song. 
As for the midifiles WINLIVE allows the calculation of the chords in real time or to view the chords 
written within the midi file 
For audio files, it allows the display of chords only if they are written within the audio file. 
Recall that the chords can be viewed both in Standard notation (A, B, C, D, etc.) or in Italian 
notation (Do, Re, Mi, etc.) 
The related chords options can be found in ToolsOptionsChords and text 
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In addition to the Chord Bar, you can view the chords directly on the text by clicking with the right 
mouse button on the main screen -> “Karaoke mode (main)” -> “Reading desk with Chords”. 

 
 

And finally you can also view the scrolling chords in the Melody Bar by selecting "SHOW ONLY 
CHORDS” in setting 
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SAMPLE PLAYER 

By pressing the button  you can access the Sample Player or by pressing the [S] key 

 
 
With this function, it is possible to reproduce quickly, even during the execution of a song, sound 
effects, images, pdf, texts or Audio Loops. 
It is possible to have 10 Banks of 10 Samples each, for a total of 100 samples. 
To upload the samples, click on the box next to each sample (when no sample is loaded, “No file 
Loaded” appears) and choose the file from the dialog. 
For each sample, you can adjust the volume. You can play the samples in Polyphony, or, by 
checking the Mono option, play them in Monophony (i.e. if one sample is running, and another is 
recalled, the running sample is terminated). 
The Comp option allows, if checked, to activate a general compressor on the samples, that 
automatically uniforms their volume. 
During the Performance, it is possible to access the sampler just pressing the [S] key, and then 
pressing keys [1] to [0] on the keyboard. To stop the reproduction of the samples in a forced way, 
press the [\] key. 
It is possible to download additional audio samples by clicking on Download Samples 
 
Chord bar in the Karaoke Monitor 
With this function you can also view the chords in the karaoke monitor very useful function 
especially for bands who want to view the chords in a second monitor. 
 
Piano Key [CTRL+H] 
By clicking on this function, a piano keyboard is shown on the screen where the notes 
corresponding to the midi track will be displayed. 

Obviously this function is only available for midifiles. 
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SUBTITLE KARAOKE MONITOR 

 
This setting allows you to insert a sliding subtitle at the bottom of the karaoke monitor allowing 
you to set the colour, font, background, size and speed of passage of the subtitle. 
It is useful when you want to launch messages to the public in combination with karaoke is 
playing. 
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NOTEPAD WINDOWS 
It allows you to view a small Notepad in various formats where you can write notes during your 
performances. By clicking on CLS you can delete the entire contents of the Notepad. 
 

 
It is selected by View ModeNotepad Windows [CTRL+N] 
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VISUAL METRONOME 
By enabling this function, a VISUAL METRONOME is activated, suitable for drummers who want to 
keep time but who want a visual reference instead of audio. 

 
This function is currently only possible for midifiles 
It is possible to “calibrate” the display of the movements by clicking in the visual Metronome box 
and pressing the right button of the mouse. 
 

https://youtu.be/QoXKFH65T30?t=134 
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Tools 

OPTIONS 
In this function and in the submenus you can customize the program according to your needs. We 
remind you that WINLIVE, leader in its category for more than 27 years, has collected the requests 
and listened to the needs of thousands of musicians and singers all over the world so as to be able 
to adapt the program in a personalized way. (see paragraph) 
 
SONGLIST EDITOR 
You can access the SongList Editor by the Tools menu  Editor  Song list editor or by clicking on 
the bottom left next to the name of the SongList. 

 
 
In order from the left we will find: 
- the corresponding key to recall the Songlist; 
- the number of songs in each Songlist: 
- the name of the Songlists 
- by ticking the STOP box, the set list will stop playing, while not ticking it allows continuous play; 
- by ticking the MELODY box, each song in the list will be played without the melodic guide 
(midifile); 
- the ORDER function provides a drop-down menu from which you can select the order mode in 
which songs will be played (if we indicate TITLE, for example, we will have an alphabetical order, 
rather than by ID, by interpreter, by author and so on). 
DEFAULT ORDER: here we can select a general order as long as there is no specific order in the 
SongList. 

https://youtu.be/y5E5pEAKWag
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EDITOR->MIXING EDITOR 
Mixing Editor can be accessed via "Tools" menu Editor 

 

With the mixing editor, you can set the progress and duration (in milliseconds) of the Cross-Fade, 
i.e. the mixing of two songs. We remind you that mixing between 2 midifiles is not possible. In this 
case we will pass from the first to the second song, by fade out and not mixing 

The green line indicates the ending song, while the red line indicates the song that will be merged 
together with the first one. 

By default, Winlive will adopt a linear type behaviour, with a progressive and constant lowering of 
the volume of the song to fade, simultaneously with a progressive and constant increase of the 
volume of the following one. You can select five pre-set curves, or draw a custom curve. 
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EDITOR->SOUND BANK EDITOR  
By clicking on “Sound bank editor” it is possible to use new sound banks. 
 

 
 
EDITOR->VOICE LIST EDITOR 
In this function it will be possible to create a sound list with reference to your connected sound 
module. These sound lists can be saved and then loaded if necessary. 
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EDITOR->USER DRUM KIT 
By clicking on "User drum kit" the screen changes as follows: 

 
 
Where you can configure your own custom drum kit. 
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EDITOR->QUICK ICONS 
 

 
In the right part of the bar you can see several coloured buttons which allow the quick access to 
several functions and modes:: 
(We remind that these quick buttons may not be viewed if the resolution of the monitor isn’t right 
as for notebook with little monitors)  

 PRF: Quick button to come back to Performance mode 

 EXP: Quick button to enter in Media Explorer mode 

 MDR: Quick button to enter in Metrodrummer (Virtual Drum Machine)  

 WDJ: Quick button for the access to Winlive DJ Control 

 CDP: Quick button for the access to CD Player 

 BKT: Quick button for the access to Background Songs 

 KMN: Access to Karaoke Monitor 

 DBS: Access to Database 

 EDT: Access to  Edit Mode 

 MDB: Opening Melody Bar 

 PNO: Opening Piano Key Board 

 CHD: Opening Chord Bar 

 VL+: Volume (up) 

 VL-: Volume (down) 

 PLY: Play 

 STP: Stop 
It is possible to edit Quick Icons and to assign to everyone some specific functions 
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EDITOR ->WINLIVE SOUND REMAPPING 
In this function we can remap our sound library according to our needs. For example, we can swap 
the instrument of the first column with that of the second in order to create our customized sound 
list 
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UTILITY -> FILE TRANSFER 
By clicking on this item we can transfer all the data present from the c: \ Program Files folder to 
the Documents folder thus obtaining unrestricted access. 
 
UTILITY -> OPEN FOLDER WINLIVE DOCUMENTS 
This utility will allow us to locate and directly open the Documents folder where Winlive files will 
be present. 
 
UTILITY -> OPEN VIRTUAL FOLDERS AND STORE 
Windows creates hidden folders where Winlive in previous versions stored important files such as 
the database. To access these particular folders directly click on this function.. 

 

UTILITY -> START WINLIVE CD PLAYER / EXTRACT 

 
 
With this function, it is possible to extract tracks from Audio CDs and save them in Wav or Mp3 
format. 
It is necessary to select them (you can select them all through the "All" button or select them 
manually by clicking on the first column), then click on the Convert button. 
You can choose between uncompressed Wav (Wave not compressed) and Mp3, varying the 
quality according to your needs (eg "Minimal Only for voice store" generates a low quality file with 
the smallest footprint on disk, while "Maximum quality” generates a high quality file, but also with 
the largest disk size). 
 
The peculiarity of this CD player is that it has the advanced features of commercial DJ CD 
players, that is, it allows you to change the tempo and intonation (Key) in real-time. 
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UTILITY-> GUITAR TUNER 
The guitar tuner could not be missing to make happy guitarists and other musicians.  

 
We can choose the tuner sound, the length of the sound (sustain), the dynamics (Dyn) and the 
Transpose. 
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SONG PERFORMED (List of songs played) 
Each song played both in Performance mode and when executed on the fly is stored by Winlive. 
You can then save this list in a text file. 
The title of the piece performed and its author are both given. In case of missing information, the 
interpreter is given (marked with an asterisk). 
Select  Tools -> Song Performed" menu; the following window will be 
displayed:

 
 
All lists are stored in the \ HISTORY folder, which can be viewed in WinlivePro in documents. 
The RESET button allows you to delete all the contents of the list. 
CLOSE closes the function. 
With the OPEN search key, it is possible to search for the location of the lists. 
The drop-down menu allows you to select when to save the list:  
1 - each time the program is closed;  
2 - at the end of each song. 
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PHYSICAL SAVING OF SONG 
This function is accessed through the menu "Tools" -> "Save Song". 

 
With this feature, changes made to Midi files can be saved either virtually or effectively. 

By ticking the "Save from first note" option, you can cut any seconds of silence that may be 
present at the beginning of a song. 

The "Output" column allows you to change channels for each individual track. 

Example: in some songs the vocal melody track is not saved on channel 4 (as foreseen in the 
standards) but in other channels, for example on channel 1. To invert the tracks it will be sufficient 
to write “4” in correspondence with channel 1, and "1" at channel 4. 
The "Track" column allows you to save or not the track 
The "Instrument" column indicates a changed instrument and saves it. 
The "Vol" column indicates any volume changes made (100 = 100% of the original volume). 
The "Dyn" column indicates any dynamic changes made 
The "Fixed Vol." Column sets a save value for the midi volume 
You can also choose to include the Karaoke text or Chords in the file. 
The "Add seconds to end" box allows you to add a number of seconds to the end of a song.You can 
choose the track to edit, and the possibility to include the text and chords. 
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With the key  changes are virtually saved to the database, while the keys  

 are used to effectively save midifiles and to save all the songs 
present in F10 in midi format. 

With the  keys you can change the file format from Midi to Wave or 
convert all the songs in F10 into Wave format. 

The key  allows you to transform a midi file into MP3 format with the 
possibility to choose the sound quality of the file by pressing the arrow key. 
 
Note: now you can save mp3s both virtually and physically 
By selecting the function Save splitted tracks (multitrack) we will have the possibility to save in 
multitrack midi if we save a midi or if we transform a midi into audio we could save as many audio 
tracks as there are original midi tracks 
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GENERATE SONGBOOK (Lyrics and chords) 
By selecting this function you can view the lyrics and chords contained in a song (midifile or 
audio)

 
There are various options for a customized view. It is possible to save in RTF or CHORDPRO format 
and then print it. 
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SYNCHRONIZATION OF TEXTS / CHORDS 
This feature is accessed through the "Tools" -> "Lyrics / Chords Synchronization" menu. 

 
It enables you to add a Karaoke text to Midi and Audio files. 

The text is loaded by pasting it into the window or by opening a TXT file with the key . 

With the key , you can save the text on a TXT file, while with the key  you can convert all 
text to the uppercase equivalent. 
With the "Import from Midi / Audio" button it is possible to import a text from a midi or audio file 
already written, but only if you are editing an audio track. 
Synchronization can be done per line, per word and per syllable. 
To synchronize, press the "Start Synchro" button. At this point the song will start, and pressing the 
enter key, repeatedly and in time with the song, will synchronize. 
Star how to enter chords by checking the "Chord mode" box. 
For any modification of the synchronized text or of the Chords, refer to the "Edit mode" section of 
the Display menu.
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GLOBAL TRANSPOSE 
With this option it is possible to apply a global transposition to our entire repertoire. 
The semitone increments are added to those existing in the stored songs. 
The display is placed at the top right in Performance mode 

 
 
WSE WINLIVE SYNTH ENGINE SETTINGS 
In this window we can set different parameters for the WINLIVE SYNTH ENGINE, that is for the 
WINLIVE internal sound bank. 
We can adjust the WSE COMPRESSOR and FILTER ENHANCER values, set the POLYPHONY, assign a 
pitch to cents, establish whether or not we want the effects on the drums and adjust the 
equalization of the internal sounds of the Winlive by enabling the parametric equalizer. We can 
enable or disable (recommended for slow PCs) the effects relating to the sounds 

 

Finally, if we have purchased the ICE SOUND PACK we can update it or decide to deactivate it 
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WINLIVE AUDIO SETTINGS 
Unlike the previous window, here we can decide the parameters relating to the audio. 
To the master track or second audio track, to the compressor or filter enhancer and finally the 
micro-tuning 

 



 35

AUTO-EXTRACTION CHORDS FROM MIDIFILE 
For midifiles it is possible to extrapolate the chords. Here you can decide several parameters: 
select the midi tracks, simplify the chords and decide how many chords for each measure 
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BACKGROUND SONGS 
This function will allow you to create a list of audio files that can be used as a background playlist 
when the Winlive is put into Stop. 
It is accessed from ToolsBACKGROUND SONGS or by clicking with the right mouse button on the 
BACKGROUND button in Performance mode 

 

Through the Add song button, you can add audio files in the playlist. Uploading playlist allows you 
to use a previously saved playlist; 

Save playlist allows you to save the list loaded at that moment you are working on it; 

Delete all the songs shown is used to delete all the songs from your list of the ones you have 
selected; 

A / a makes the font smaller while a / A makes the font bigger and finally Random allows random 
playback of the tracks in the background. 

This function also allows you to adjust the execution volume, the fade in for a gradual entry of the 
substrate and the fade out for a gradual exit. 

With the initial silence cut, it is possible to eliminate the silences at the beginning of the song 
finally it is possible to establish a wait (in seconds) before starting.
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SCROLLING KARAOKE OPTION 
On this screen, you can use various parameters to customize the scrolling text and moving 
background images. We remind you that at the moment this function is not available for Mac OSx 
systems 

 
 
GUIDE 
The manuals and audio and video media for the program are displayed 
 
 
SUPPORT 
The current version of the program is displayed. The personal account, serial number and related 
license. It is also possible to log into your account on the Promusicsoftware website. 
 
REPAIR / INSTALL VIDEO CODEC 
It can rarely happen that, especially due to Windows updates, video files are not played properly 
(no sound or no video). This feature allows us to restore everything. For example, if we launch a 
video and we do not hear the audio, we can click on the following function then OPEN FOLDER and 
finally launch the K-Lite_Codec_Pack_1205_Basic file. Continue until you install the codec package. 
At the end of the installation we will hear the missing audio 
 
UPDATES 

This function will allow us to verify that there are new updates to the 
program, free or paid
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Performance mode 

Below is the ‘’Performance’’ screen of WINLIVE PRO SYNTH 11 
 

 
 
 
The SongList 

The SongList is the ‘’heart of the program’’ accessible through function Keys or  
The name of the song will be showed in the grid (as set in the database) as well as the typology, so 
the file format, indicated by a specific colour. 
The songs with lyrics are distinguished by the icon . 
The cursor buttons (the 4 arrows) of the keyboard can be used to select the files. 
There are a total of 39 SongLists (or playlists) that can be called with buttons: 

 For Windows 

 from F1 to F9 (from playlist 1 to 9)  

 Shift + [ from F1 to F10 ] (from playlist 11 to 20)  

 Ctrl + [ from F1 to F10 ] (from playlist 21 to 30) 

 Shift + Ctrl + [ from F1 to F10 ] (from playlist 31 to 40) 
 

 For Mac 

 Push the button ‘’?’’ and type the playlist number (from playlist 1 to 40)  
 
In addition, it is possible to set special SongLists: 
- F10 (temporary SongList) it is possible to add songs from other SongLists by pressing the button 
‘INS’ or clicking the right mouse button then ‘add to F10’ 
- F11, F12 (song folder list) it is possible to add all files of a folder to one of the two lists, to set a 

folder push from keyboard ‘\’ or  
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The combination of buttons Shift + F11 or Shift + F12 of the keyboard allows you to view the 
whole database in a single SongList 

The button BACKSPACE or  opens the research bar (picture below) 
 

 
The research can be done on the single SongList or on everyone else (putting the check on ‘’All The 
SongLists’’) 
It is possible to scroll the results through the button “TAB” of the keyboard, for example a 
research of ‘’HELLO’’ will give you results such as ‘’HELLO DOLLY’’, ‘’I SAY HELLO’’, and so on. 
If the author and the artist are set in the database, we can filter the playlist viewing only the 
results related to certain authors or artists. To view the playlist another time, you just need to click 
on ‘’ALL’’. It is now possible to do a research in the whole database simply pushing buttons “Shift + 
F11” or “Shift + F12” from keyboard, which allows you to view all the results.  
From drop-down menu, we can select the typology of file to search for (midi, audio, video). 
Furthermore, it is possible to view and filter the songs according to certain features: for example, 
if we type the word ‘’WAY’’ then pressing the button ‘’TITLE’’, you could see only the songs that 
contain the word ‘’WAY’’. 
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 POPUP MENU 

 
Clicking on right button of the mouse, on the main screen of Winlive it is possible to open a Popup 
Menu, from which you can have access to different functionalities: 
 

 Load File: read files quickly without inserting them in the database; 

 Save File: physical saving of files (see dedicated section); 

 Load song Audio multitrack: load an audio multitrack song (see dedicated section); 

 Generate Songbook (lyrics and chords): A file with lyrics and chords is generated; 

 Events managment: Enable the Events Window feature to associate events with midi and 
audio files. This function generates an associated file with the extension * .wen 

 Set Folder: quick access to SongFolder List (F11 and F12); 

 Fullscreen: full screen view of the main screen; 

 Normal: restore the view with menu and control bar;  

 Minimize: the picture of Performane is closed as icon; 

 Window size: allows to reduce the window dimensions; 

 Karaoke mode: allows to choose the different modes: Multiline scrolling karaoke, Classic (2 
lines), Modern Style (4 lines), Music stand Mode, Music stand with chords, Music stand 6 lines, 2  
lines at the top (musician style) or no karaoke; 

 Enlarge Font: allows to enlarge the font dimension; 

 Reduce Font : allows to reduce the font dimension; 

 Font: allows to change font type, style and dimensions; 

 Use background image: displays or removes the background image; 

 Monitor Background: allows you to load an image as background 

 Karaoke Monitor: allows to enable the second screen (see dedicated section); 

 Karaoke Monitor mode: allows to choose the view mode of the monitor and the dimension 
of font; 

 Clone Monitor: enables and disables a clone monitor of main monitor or karaoke monitor; 

 Do not include in Performed song list: (avoid inserting the song in the list of songs 
performed); 

 Lock keyboard (CTRL+S): choosing this function the buttons are disabled; pushing a function 
button the keyboard restarts working; 
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 Stop-Panic: stops the playback of the files and re-initialises any expander; 

 Import into database: import a song directly into the database. 

 YouTube start: set a starting point of the song connected to YouTube 
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CONTROL BAR 

 

 
 
The CONTROL BAR is divided into 4 parts, the left part (transport bar) is  reserved to control 
buttons of the song, the second part is related to the song which is playing at the moment (Main 
Song), the third part to the song which has been booked (next song). 
The fourth part is composed of a series of buttons, quick to access to different functions and mode 
QUICK ICONS (these quick buttons may not be viewed if the monitor resolution doesn’t allow it: 
for example netbook or notebook with low resolution screen)  
 
Through the buttons placed in the bar below it is possible to control: 
Melody channel (on or off) for the midis; 
The tempo in BPM compared to the original tempo for midifiles; 
The key change for midi, audio and video files.  
Once the time and the custom tone are set (also for volume and other parameters which can be 
checked from Mixer- see dedicated section), it is possible to save these parameters virtually in the 

database, pushing the button  placed up. So, every time you will launch the edit file, this will 
be performed with all the made changes and the modified parameters will be conserved also after 
quitting the program.  
 
By clicking on the song title or on the Artist, you can access the Quick Edit function. 

 
This function allows so the quick editing in Title, Artist, Author field and it is also possible to 
change the SongList. 
It is also possible to associate an image / pdf or text (txt,rtf) 

Through the button  it is possible to locate quickly the file on Hard disk 

With the button  it is possible to cancel the file in the database (the physical file stays instead in 
Hard disk). Clicking twice on the icon  it is possible to choose arbitrarily whether the song has 
lyrics or not. 
 
MARKERS 

 
The markers allow quick access to various sections within a song. To register them, it is necessary 
to enter the Edit mode (see dedicated chapter). 
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When one of the markers is set as the starting Marker, the background of the button 
corresponding to the Marker turns green; on the other hand, when one of the markers is set as 
the final Marker, the background turns red. 
Setting the starting markers can be useful, for example, in order to skip the introductory part and 
start the song directly from the verse. 
It is possible to quickly access the markers by clicking with the mouse on the button corresponding 
to the Marker, or by using the numeric keys (from 1 to 0). For midi files, pressing the Marker via 
the numeric keypad will allow you to access the reserved point "in time". 
The creation of the markers can be performed in the Edit mode or they can be created "on the fly" 
in the performance mode by pressing the ALT + 1, ALT + 2 ... keys. ALT + 10 corresponding to the 
10 markers for each file (midi, audio or video) 
The midifile purchased from Songservice by M-Live contain the markers already inserted 
 
PRE-LISTENING 
To use this function correctly you need a second audio interface (see chapter Options). It is 

accessed by clicking on the button  after booking an audio song (MP3 or WAV). 

 
 
For a quick setting, pause at the right time (typically SPACEBAR) and then press ENTER or click on 

the button . When called, the song will start from the chosen cue point. 
 
For more detailed use: 
With the Set key (J) it is possible to set the starting point of the song, and with the Test key (H) it is 
possible to preview the song from the set point. With the << or >> transport keys it is possible to 
edit the starting point precisely. It is also possible, via the Gain bar, to set the volume of the song. 
Once the pre-listening is finished, you can confirm the cue point with CueOK (or G key) and exit by 

saving the changes with the key , or exit and cancel by clicking on  
When the song being played ends, or mixing (Y key), fading out (Q key) or immediate start (send), 
the booked song will start from the point set during pre-listening. 
  
 



 44

MIXER 
To select the midi channels or manage the audio it is necessary to open the mixer (key 'X') or click 

on . 
The Mixer window located on the left side of the "Performance" screen allows you to keep under 
control various parameters both 
midi and audio. 

 

 

Click on an item to open a drop-down menu and 
make a choice, including enabling / disabling the 
track, soloing it or activating them all. It is also 
possible to go into the detail of the track, apply an 
MFX effect, select Drum Editing and User Sound 
Editing (see detail). 

In red the muted channels in white the active ones. 

You can enable / disable a metronome by clicking on 
the corresponding button. 

The Comp key activates and deactivates the 
compression of the dynamics of midi files. 

Through the Device column it is possible to select a 
different Midi output for each individual channel. You 
can apply these Device settings for all songs by 
clicking on the Lock button. 

Through the Remix Style it is possible to change the 
style of the song, choosing between the various styles 
and being able to apply 2 types of variation and the 
use of percussion, the intro and the end of the style. 
This is obviously valid only for midi file;; 

In the Audio section we find the Volume Fader to 
adjust the level of the output audio, the three faders 
for equalizing the sound; Gain adjusts the gain of the 
audio backing track; the V.Att fader regulates the 
attenuation of the voice. The Master Track Effects 
faders (A - B) adjust the volume of the effects 
selected in the drop-down menu in the 
corresponding box; 

Pan and right and left channel management for MPX 
files 

2nd Track Effects (C - D) adjust the volume of the 
effects selected in the drop-down menu in the 
corresponding box of the second track; 
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The Drum Part Off section allows you to exclude the sounds of the drum parts, allowing you to 
individually choose each part of the drum to be excluded. 
The MIDI section features a volume fader to increase or decrease the same, and the faders to dose 
the Reverb and Chorus level of the midi song. 
The "Winlive Midi Cover" function allows you to choose one of the preset registers in order to vary 
the feeling and style of a midi file, a must try !! 
* The effectiveness of this functionality varies depending on the song. 
 
The detail (in the mixer, click on the name of an instrument) 

 
 
From this window it is possible to control in detail the functions of a track, choose the instrument 
from a family of sounds, the Track, the Volume, the Pan, the Chorus, the Delay and Reverberation 
(in case of expander), the Key (+/- 12 semitones), the activity and put it in "solo". 
The new "MFX synth engine" function allows the addition of an effect between distortions, 
compressors, emphasis of mids, highs and lows etc. 
The abbreviation 'PC' identifies the transmitted Program Change number. 
It is possible to edit the sounds by varying different parameters (only works in the case of 
expander): 
- Stamp: increases or decreases the resonance; 
- CutOff: increases or decreases the frequency cut; 
- - Attack / Release / Decay: regulates the envelope of the sound, according to the following 

scheme:
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 The screen, in case of selection of Channel 10 / Drum, changes as 
follows:

 
 
This will display the standard DrumKits instead of the sound families. 
It is possible, if an external tone generator is used, to choose also non-standard DrumKit by 
displaying the relative Program Change. 
4 banks can be created with 8 sounds each; for each sound it is possible to edit the name, the 
Program Change to be sent [0… 127], the Control Change value [0… 127] (it is possible to send the 
CC # 0 and / or the CC # 32, refer to the manual expander) and finally all the various parameters 
that characterize the sound. 
For a preview, you can click in the box at the bottom left or press the left Ctrl key. 

Once the bank has been created, it must be saved by clicking on the button .  
It is also possible to export sound banks to external files, and re-import them later. 
This function is very useful if you use more than one external expander, as you can create several 
customized sound files, one for each expander. 
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It is also possible to change the single sound of a drum using the Drum Editing function with 
dynamic variations (% Dyn) for each sound 
  

 
 

The maximum number of editable sounds is 8, and for each sound you can also edit the intensity 

of the dynamic, and listen to them in preview by clicking on  
The window at the bottom will show the names of all the drum instruments used by the current 
song, highlighting the modified ones in yellow. By clicking on reset you can restore the original 
drum. 

Virtual save allows you to store the change in the database. 

In the mixer section we also find the management of MPX files. In this mode you can manage and 
save the left or right channel of the audio file. 
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VIRTUAL KEYBOARD 

Enabled by pressing the button  at the top right of the video in Performance mode, Virtual 
Keyboard allows you to activate this screen as shown in the photo below: 

 
 
It allows you to use the basic commands if we use WINLIVE on TABLET WINDOWS or touch screen. 
The F1 / F9, Shift F1 / F10, Ctrl F1 / F10, Shift + Ctrl F1 / F10 keys are used to select the SongLists; 
Esc closes the list; 
the left and right arrows scroll the list in the commanded direction; 
the + F10 and - F10 keys remove or add songs in the provisional list F10; 
Start, allows you to start playing the selected song; 
Mix, allows mixing between one song and the next; 
the X button closes this screen. 
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AUDIO TRACK RECORDING 
This function allows you to record an audio track on a song included in the database  

Start a song and press the record key:  
 

 
 
From the panel you can select the Audio device, Line and input Volume that has a signal 
adjustment fader. The Filename indicates the saving path of the recorded track, but it is possible 
to change it by typing the appropriate key. 
WAV Format indicates the standard format for saving the track, but this can also be changed.  
By clicking on "Start Test" you can perform a recording test by checking the incoming volume level. 
At the end of the test, the button "Stop test" allows you to return to the initial condition. 
The "Start record" and "Stop" buttons are used respectively to start and end recording tracks. 
The recorded track will be associated with the song in database in the MEDIA column and in 
performance a "2nd track" window will appear next to the song title with a small vertical cursor 
that represents the volume of the recorded track. 

 

Note: at the moment this function is not enabled on Mac OSx
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Edit mode 

Song Markers 

 

The use of the Markers allows the jump in real time to different points of the song. For example, 
you can associate the first marker with the introduction, the second one with the first verse, the 
third in correspondence of the refrain, etc. 

The maximum number of markers is 10 per song. 
There are several ways to register new Markers while reproducing a song: 

 Pressing ALT + [number from 1 to 0]; 

  Clicking on the Marker you want to generate, then click on the button  

 By a right-clicking on the bar at the bottom 

 Clicking the 'L' key (adds them in order). 
 
To relocate the Markers: 

• Use the ALT and + or ALT and - keys 
• Left click on the bar at the bottom, and move it with the mouse. 
• Use the keys for an increasingly precise Marker position 

 
To remove a Marker, select it on the table or on the bar at the bottom, and then press DELETE. 
You can rename the markers by double clicking on the table. 

Using the key  it is possible to add images associated with the various Markers (for example, 
you can add the image of a score) so that you can show one or more images per song in progress. 
 
You can use Markers to set a song starting and ending point. 
For example, Marker 2 can be set to the first verse, skipping the Introduction, and Marker 9 at the 
end of the penultimate verse, to end the song before the "tail". 
Once the Markers have been set, and any starting and ending points, it is necessary to save by 
clicking on the Save button. 
The Markers can be saved only if the file (Audio or Midi) has been previously imported into the 
database. 
 
While the song is playing, the Markers can be quickly called up by pressing the number on the 
corresponding keyboard while for the midifiles the next beat of the song will be expected. 
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With the combination Shift + [numeric key], the changeover to the called Marker will take place 
immediately. 
If the Markers are saved they will be visible in the next song bar, pressing Control + [numeric key], 
or clicking on the booked song Marker, in Performance, will allow the next song to start from an 
arbitrarily chosen Marker. 
 
Midi Mixer 
Next to the markers function, a simplified version of the Mixer is visible, valid only for midifiles. 

 
 
For each individual channel it is possible to adjust the volume, mute or change instruments (by 
clicking on the instrument name of the corresponding channel).
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KARAOKE EDITOR  

It can be activated with the key .  

 
With this function, it is possible to edit the Karaoke text in an advanced way. 
By clicking on each word, it is possible to edit it by changing the text, or move it graphically by 
anticipating or postponing it. 
The Shift - Slide allows you to translate the entire text, anticipating or postponing it by a certain 
number of Milliseconds, indicated hereafter. 
Collapse-Expand compresses or expands the distribution of text 

The button  capitalizes the whole text. 

The button  automatically optimizes the text by moving the page changes in order to simplify 
the reading of the Karaoke during the playback; it removes the double empty lines or pages too. 

The button  allows the insertion of new text. 

The button  deletes all lyrics 
 
With the "SAVE" key you save all the changes made. 
 
Chord Editor 

Like the Karaoke Editor, you can access the Chord Editor to edit the chords, using the button  
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Database 

Below is the "Database" grid of Winlive Pro / Pro Synth 11 

 
 
- Create, Open and Save 
From Performance it is possible to access the database by clicking on the menu at the top 
Database -> Database or from View mode -> Database or by clicking the quick button (quick 
icons) DBS 
It can be accessed without using the mouse by pressing the CTRL + ALT + D keys 
WINLIVE PRO 11 allows you to manage multiple databases. 

 To create a new database press the button:   
Winlive will ask whether to save the already present database, after which it will empty the 
current database. 

 To open an existing database press the button:  
Winlive will ask you to specify the name of the database to open. 

 To save the current database with a name press:  
Winlive will ask you to specify the name of the database to save. 

 To import a database created with versions 5.5 / 4.5 / 4.6 / 4.7 / 5.0 / 5.5 press:  
Winlive will ask you to specify the name of the database to be imported. 

 To make a backup of the database press:  

 To restore the previously created backup press the button:  
Winlive will show the backup date and time. 
 
Warning: creating a new database, or restoring a backup, will delete the one previously created if 
you do not save it. 
- Edit the cells 



 54

You can change the cells values by double clicking on each cell if you are in "Selection" mode or by 
pressing the "E" key. You just need a single click when in "Edit" mode. 
On some fields the entry process will be guided, on others it is possible to write directly inside, 
other fields are informative and it will not be possible to edit them, for example Type field, ID... 
 
It is possible to edit some values quickly through the "Preview" window that allows you to listen 
quickly to a preview with new settings applied. 

Right clicking on a cell (or on a selection of cells) allows you to access a menu through 
which you can perform various operations: 
- Select all: highlight all songs 
- Reset selection: cancels the selection of the tracks 
- Copy: copy 
- Edit: edit the selected cell 
- Multi field insertion: allows a multiple selection on several songs at the same time. 
- Sort A-Z: sort in ascending order in the selected column 
- Sort Z-A: sort in descending order in the selected column 
- Delete database: delete the song from the database but not physically from the hard disk 
- Sort grouped by SongList: sorting in ascending order according to the SongList 
- Get interpreter / author from folder name: the folder name is displayed in the Artist  
column. 
- Move to List: move the selected songs from one SongList to another 
- Copy to List: copy the selected songs to a SongList 
- Restore files-Path (scanning): this important function allows you to restore the path if the 
files have been physically moved from one folder to another. It is also possible to restore 
the path for the files of the MEDIA and TEXTFILES columns 
- Replace part of the path: replaces a complete route or part of it with a different one. For 
example if I physically moved some songs from the folder C: \ SONGS in D: \ MY SONGS I 
have to select the interested songs and write as in the picture 

 
- Mute channels: to select the channels to be muted 
- Copy IN: physically copies the songs from one folder to another with the possibility of 

updating the paths in the database 
- Move IN: physically move the songs from one folder to another with the possibility of 

updating the paths in the database 

- Find and show duplicate files: this function is accessible from the key .  
It shows duplicates in different ways. Most of times, the duplicated files can be conceived 
as a song coming from the same list or with the same title of the first one. 
Once the database field to be set as a parameter for the duplicate file has been arranged, 
the priority must be chosen (ID as loading order or belonging SongList). 
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Once the CHECK button is pressed, the duplicated tracks come up. 

 
 

This operation is irreversible, therefore we recommend that you save the database first. 
 
- File analysis - Mp3 tag info: this function extrapolates the information inside the mp3 files such 
as title, artist etc. 
- Convert title to: set of text functions such as upper case, lower case, eliminate unnecessary 
spaces, etc. for example Use file name as title: the file name is displayed in the TITLE column 
- Divide title field: allows to divide title and Artist if these details are both present in the TITLE 
column 
- Duplicate: it is used to duplicate the selected files 
- Locate files on disk: directly opens the source folder of the files on the hard disk 
- Remove file from disk: allows you to physically delete the file from the disk and simultaneously 
from the database. This function is irreversible. 
- Create and save YTB file (YouTube song): once a YouTube song is selected, it is saved into an 
external physical file. Do not forget that the YouTube file is a simple link to a YouTube video. 

 
 
- Multi-selection 
If you hold down the CTRL key, you can select multiple songs in order to operate in groups. 
If you are in "Selection" mode, the song is deselected by clicking on it, while in "Edit" mode just 
click on any field to deselect everything. 
 
- Database columns 
Below is the sequence the columns of the database 
ID: indicates the number in chronological progression of the imported songs 
SongList: the belonging SongList is displayed 
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Title: indicates the title of the song 
Artist: performer of the piece (artist) 
Author: author of the piece.  
Genre_Notes: we can enter the genre of the song or annotations on the song itself 
Type: value not editable. Indicates the type of file (mid, mp3, video, etc.) 
Karaoke: value not editable. Indicates the presence of the text within the file. It is valid only for 
midi files and mp3s 
Tempo: value not editable. It is the time relative to the song 
TempoP: it is the edited time 
ChOff: indicates muted channels for midifiles 
Transpose: displays the changed pitch 
Volume: the standard volume of the song (100 means volume as in the original) 
Media: file associated with the song (for example associating a pdf, an image, a sound, etc.) 
Textfile: Text associated with the song (txt or rtf) 
Order: allows you to create a custom order of the songs in the set list 
When we want to create a custom order, we have to insert a series of numbers in order to create 
a numerical criterion 
For example if we want to create a playlist with this personalized sequence 
IMAGINE - YESTERDAY - MICHELLE - LET IT BE 
We will insert these numbers for example: IMAGINE (15) - YESTERDAY (21) - MICHELLE (50) - LET IT 
BE (88). No matter what numbers we enter, the important thing is to create an increasing number 
sequence 
After doing this, remember to assign this sorting order to this SongList in SONGLIST EDITOR 

https://youtu.be/y5E5pEAKWag 
Key: indicates the key of the song 
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-Import of the songs 
Start entering some songs by clicking on the left side of the database called Explorer. 
Select a folder and open it with a double click. The songs contained in the folder in question will 
appear. If the folder is located on the desktop or in Docs folder, we can view them simply by 

clicking the buttons  
 
We can select a song, several songs (by holding down the CTRL key) or all the songs in the folder 

by pressing the button  

By clicking on  , the selected files are imported. 
 

 
 
Now you can select: 
• The destination SongList; 
• Copy TO: a secondary folder where to save the copies of the imported files; 
• MOVE: the selected files are physically moved to another folder 
• The mute channels for Midi files; 
• Use file name as title: displays the name of the file as the title of the song (Title column) instead 
of the title that is usually included in the file itself; 
• Quick import: speeds up the import by ignoring some information; 
• Do not import if it already exists in the database: avoid uploading files down in the database; 
• Write Interpreter as folder name: write the artist of the piece (Artist column) by taking 
information from the last folder that contained the above mentioned song. 
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Note: fast import performs the process extremely quickly but does not allow thorough checks on 
the integrity of the file and the MP3 tags. 
 
In any case, files that are deemed invalid, such as Midi that have notes jammed or lacking vital 
information will not be imported in order not to compromise any user performance. 
In any case, at the end of the import a short report will appear about the imported and invalid 
files. 
 
Attention: the integrity checks will not be provided on the files of the Song Folder Lists and on the 
files launched with Load File 
 
Database keys 

 
Respectively: deselect all, select all, select multiple 

 
 
 
 
 

 
Set filters on the display based on the type of File and / or the SongList to 

which it belongs 

 

 

 

In the order: 
- Return to Performance mode 
- Open a database (new) 
- Save a database 
- New database 
- Import database from a previous version 
- Find and show duplicate files 
- Make a backup of the database 
- Restoration of the previous backup 
- Database setup for changing the display parameters 

 

 

 

 
 
Top row: 
- Move the songs to another SongList 
- Open Import Song window 

 

- Delete song or song selection from database  

- Delete all the songs now shown in the grid even if not selected  
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- Use file name as title for the selected song 
- Search for a title among the songs on the grid 
- Open Karaoke monitor 
- Import the Playlists of Vanbasco 
 
 
Bottom row: 
 

 

- Copy the file to another physical destination 
- Search for “orphan” files (files missing or with wrong path) 
- Open the SongList Manager (SongList editor) 
- Replaces the path or file name 
- Create a database report in HTML format 
- Create a database report in Excel format 
- Locate the file on the hard disk 
- Title optimization 

 

  

- ORPHAN FILES (missing files) 

To search for orphan files, click on the button  

 

Tip: positioning an icon on a small label will give a brief description 

 

Orphan Files 
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The Orphan File Search feature allows you to scan the entire database looking for files that are 
missing in a way that may have been deleted or moved to another folder.  

To find orphan files, press the "Check" button. Once the scan is complete, you can delete matches 
from the database (Remove All), or show them in the database. The Search function searches for 
all orphan files and once identified, the relative path in the database is automatically updated.  

With New path, on the other hand, the new path is updated manually.
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Media explorer 

We suggest our users who have tens of thousands of songs use the two modes: Database and 
Media Explorer 

In the Database it would be better to insert the songs of your own repertoire that need the 
management and the personalized saving of different parameters while in Media Explorer the 
simple execution of songs perhaps with variation of transposition and annotations for each song. 
The latter mode is especially suitable for those who perform karaoke performances 

In Media Explorer, therefore, you can run the Songs directly from the hard disk, with a very fast 
and intelligent research; you can also apply display filters and possibly import them into Winlive 
database

 

By clicking on Default >>> you can open predefined paths or you can select a starting folder that 
Winlive will search.
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RESEARCH 

Once you have entered the title of the song or part of it to be searched, WINLIVE quickly searches 
for all the songs that meet the search criteria. 

Once the search has been done, you can select the song and play it on the fly simply by pressing 

Enter, or you can book it by pressing the space bar or by clicking on the button . With 

the button  you can play the booked song (or by pressing the CTRL + Enter keys). 

NB: To switch to the booked song by mixing press the CTRL + Y keys, while to fade away the CTRL + 
Q keys 

If you want to book more songs you have to go to the song (possibly change the key and 

annotations) click on   or the INS key and so on. 

The booked songs will be displayed by pressing the F10 key or clicking on the button  

The reserved tracks will be displayed and infinite PLAYLISTS can be created, saved and recalled 
later. 
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YOUTUBE VIDEO SONGS 
WARNING: please accept the conditions of YOUTUBE before using this service 
We remind you that the YOUTUBE service is granted until the next version of WINLIVE is 
released. It will be renewed only when upgrading your Winlive version once delivered. 
 
This function is accessible through the YouTube button located on the other on the left, in 
Performance mode or through View -> YouTube songs or YouTube SongList 
Or press the keys (CTRL + ALT + Y) 

 

As you can see in the image, this function allows you to search and display on the screen the songs 
present directly on YouTube through the search for the title and the artist. 

This function requires an internet connection. 

Within the function, a search filter is already set for the karaoke backing tracks, in addition to the 
display, it is also possible to import them into a SongList of the database and enter the title, artist, 
author, key. 

Attention: It is not possible to modify the song and download the song itself. It is only possible to 
import the link into the database and recall it as if it were any piece of our database. 
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In addition to the search function, it is possible to view a list of songs from Youtube links by simply 
clicking on YouTube SongList (CTRL+ALT+L) 

Once the YouTube file has been launched, it is possible to remove an initial part (for example, to 
skip an unwanted introduction) by right-clicking on Performance and selecting Insert YouTube 
start point, inserting the seconds in order to start the song from the desired point. 
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METRODRUMMER  

With the MetroDrummer you can use a real electronic drum with rhythmic patterns, accessible 
through View -> MetroDrummer or through the MDR button located on the right side of the 
Performance mode (CTRL+ALT+B) 

 

The Metrodrummer can be used independently by reproducing the various rhythms (more than 
220) with classic drum patterns, such as Intro, Standard, Variation and so on. 
Very useful, for example, when you want to perform acoustic pieces with the need for a basic 
rhythmic structure (keys: \ 1 2 3 4 5 6 and 7 for the various drum patterns) 

The MetroDrummer can also be used as an electronic metronome for our classic teaching 
exercises by pressing the METRONOME button 
Furthermore, with MetroDrummer it is possible to synchronize our midifiles with the various 
rhythms, for example to perform a MEDLEY live by playing the various midifiles that we will 
perform at the same rhythm. 
Click on MIDIFILE SYNCRO (key: 9) so that the first midifile and then all the other midifiles that we 
want to play will start with the present rhythm while with STYLE SYNCRO (key: 0) it is the midifile 
that synchronizes the rhythm of the MetroDrummer.
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WINLIVE DJ CONTROL  

Simplified section for DJs, accessible through View -> Winlive DJ control or through the WDJ 
button in Performance mode (keys: CTRL+ALT+J) 

 

Winlive DJ mode with BPM recognition for Audio files with real-time effects, allows you to perform 
both manual and automatic mixes. 

To perform the Automatic mix with the first track in play and the second one booked, just click 
first on Tempo Sync and then on Auto mix, in this way Winlive DJ will automatically switch from 
one track to another. 

In order to mix manually, so with the first track in play and the second one booked, just click first 
on Tempo sync and then on Manual mix. In this case, you will find a writing in red (Mix 2%). Click 
on it to advance the mixing percentage and gradually switch from one track to another. 

In addition to the various ways of mixing, the Winlive DJ also allows you to 
insert effects such as Reverse Play, auto WHA and Phaser that can be used 
through the pad on the right.
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Options 

General Options: 

 
Stop at the end of each song 
Disables automatic reservation of the next song in the list 
 
Stop of the song even if reserved 
Disables automatic song playback even if reserved 
 
Random next song 
Randomly book the next song 
 
Disable automatic song start 
Each song requested does not start automatically but is started with the enter key 
 
Sliding Melody Bar 
The melody bar, which can be called up from the CTRL + E performance, can be fixed in screens or 
sliding 
 
View markers in the Melody bar 
As a description 
 
Use measure indicators in Melody bar and Notation 
During the scrolling of the Melody bar it is possible to view a progressive measurement 
numbering. 
 
Melody bar bottom or top 
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Position the Melody bar when performing in performance 
Vertical Melody indicators, fixed horizontal, horizontal with height 
As a description 
 
Melody Bar only on main screen, only on Karaoke monitor, on both 
As a description 
 
Automatic mixing 
Mixing mode between a song and the next one or the one reserved: only audio, audio and midi, 
disabled 
 
Milliseconds of waiting before the start 
Set the number of milliseconds that the program will wait before playing the song 
 
Talkover volume 
By pressing the "P" key during performance, the volume level drops to the chosen percentage, 
allowing you to speak while the song is playing in the background 
 
Tablet keyboard 
Allows to position the virtual keyboard (suitable for Tablet devices) on the right, left or disable it 
 
Keys 1,2, ..., 0 
You can use the numeric keys to quickly access the Markers or to mute tracks 1 through 10 
 
Use the Space for bar 
You can use the space bar to play or pause a song, or to show or hide the SongList 
 
Search Window position 
Allows you to move the "search song" window down or up on the screen 
 
Use ESC twice to stop instead of ESC 
If checked, the stop will be effective by pressing ESC twice instead of once 
 
View clock 
View a clock in the upper right 
 
Use high contrast indications 
As a description. Requires restarting the program 
 
Do not use leds 
The LEDs are positioned and are active in correspondence with the various instruments displayed 
in the Mixer interface; by ticking this box they are deactivated. 
 
Do not use the VU-Meter for midi 
The Vu-Meter is active in the Mixer interface to signal the sound level and can be deactivated by 
ticking the appropriate box. 
 
CountDown flashing end song 
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The countdown is present at the top center of the performance screen and flashes a few seconds 
before the end of the song being played; by removing the check in the appropriate box, you can 
cancel it. 
 
Automatically hide Tablet keyboard 
By ticking the appropriate box, the tablet keyboard can be hidden 
 
Auto-Open Visual Mixer when audio multitrack starts 
This function is related to the audio multitrack song. You can decide whether to open 
automatically when loading an audio multitrack song. 
 
Song booked in Karaoke monitor 
Option to display or not the booked song in the karaoke monitor, also sizing the display character 
 
Key Information and Karaoke Title 
Option to view the song being played and its pitch in the karaoke monitor, also sizing the display 
character 
 
Language 
Choice of preferred language. 
 
ADVANCED SETTINGS 
(It is recommended not to change the default settings unless you are an expert user) 
 
Screen Double Buffer 
Use a graphically double Buffer to reduce flicker and improve graphic quality. 
(Winlive may need to be restarted to implement the new settings) 
Use it only on computers with a good dedicated graphics card. 
Check for updates at startup 
If checked, it allows you to automatically check for updates every time you start. 
Interface Update 
Every tot of milliseconds the Winlive will update the graphical interface. 
 
Enable frame jump 
Mixing two videos delays the display of the image of the following video 
It is ticked to save resources on less performing computers 
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Midi 1 options: 

 

Device Midi 
It is possible to set a device for Midi both physical (Expander, Keyboard) and virtual (Roland VSC, 
Miscrosoft SoftSynth, etc.). 
The Refresh key updates the list if you have just connected a new device. 
 
Use Winlive Synth Engine (WSE) 
This feature allows you to use the digital sound bank of the WINLIVE PRO SYNTH 11 without being 
bound by external expanders. 
 
Out 
Default output for the output of the Midi stream with the possibility of setting the right or left 
channel of the indicated output 
 
Midi Out + WSE 
Allows you to use the Winlive Synth Engine with a midi out to be selected in midi devices. 
 
… 
It allows you to select another digital sound bank (soundfont .sf2) With X you can reset and 
restore the Winlive sound bank 
 
Start from the First Note 
If checked, it allows you to position yourself directly on the first note useful when opening the 
Midi File, thus allowing immediate access. 
 
Stop on the last NOTE-OFF 
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If checked, it allows you to end the song at the last NOTE-OFF, truncating any tail of the sound. 
Midi tracks Vol% (1-100) 
It allows the variation of the general volume of midi tracks in percentage. 
Midifile compression 
Enables compression of note dynamics of midi files according to the min and max values set 
below. 
 
Midi melody channel 
Defines the midi channel for the melody (as standard set on midi channel 4) 
 
Device Metronome 
It is possible to set a different device for the metronome, or use the same main device. 
Warning: using a different device for the metronome could cause timing problems, due to any 
different latencies of the midi device used. 
 
Initial measures with metronome 
The metronome will be played back up to the number of beats chosen after which it is 
automatically turned off (it is convenient to use this function together with the de-selection of 
start from the first note). 
 
Sounds of the Metronome 
This part of the menu will allow you to change the sound of the metronome and set the volume of 
it. 
 
Metronome compensation 
It is used to "calibrate" the metronome if there are latency problems 
In the drop-down window below you can determine whether the Metronome is midi or audio 
 
Batting midi Markers 
 
Markers in measures mode 
As per description 
 
Midi input 
Allows the connection of a keyboard or any MIDI IN device to play the internal sounds of the 
WINLIVE externally. 
 
Ignore Midi track reading 
Ignores the reading of parameters other than note on and note off of the track selected for midi 
files, if set to off it is disabled 
 
Keyboard sensitivity 
Adjusts the touch sensitivity on the midi keyboard possibly assigned in the midi input. 
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Midi 2 options: 
 

 
 
Resolution timer 
Midi messages are sent in bulk every tot milliseconds. Usually 10 milliseconds is the optimal 
resolution. 
An increase in the timer decreases the CPU load but could clog the Midi device, a decrease better 
distributes the midi messages but could weigh on slow CPUs. 
In general, the default working range within which the time is perceptibly precise varies from 5 to 
30 milliseconds. 
 
Midi Engine Multitasking 
The multitasking midi engine allows the execution of multiple midi streams simultaneously, 
increasing the loading and execution speed, excellent for computers with good performance. 
 
Filter Non GM-GS messages 
Leave out the redundant midi events considered useless for the reproduction of Midi files like 
Control Change etc ... 
Some devices with advanced functions such as Karaoke or Vocalist output, in combination with 
some specific songs, may need to send these messages. 
Deselect it only if you encounter such problems. 
 
Light Load 
Leave out some midi events like Pitch-bend, AfterTouch etc ... 
Enable it only if you experience slowdowns in Midi playback. 
 
Notes Partial OFF 
An alternative way to use the pitch change reset, paused and at the end of the song. 
Do not enable it if you use an Expander otherwise the notes will decay very slowly 
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Send Reset Sysex before the song 
Send the Sysex standard reset message before each midi song, the type of reset message (GM, GS 
etc.) can be chosen from the drop-down menu just below. 
Program changes start at 1 
By convention, the displayed program changes can start from 1 instead of 0 (only for visual 
indication) 
 
Drum compatibility M-live Xlight 
Exclude some drum kits that can block M-live xlight and M-live Xlight 2, do not select if you use 
midi devices other than the two just listed. 
 
Ignore Sysex reset messages 
Ignore the standard sysex reset messages already included in the midi file. 
 
Ms waiting before the first note 
Indicates the waiting time in milliseconds before starting the midifile 
This mode is useful for older expander who need a waiting time to manage the flow of incoming 
midi data in an optimal way. 
 
Send SysEx Messages 
Enable the sending of SysEx messages contained in the midi-file during playback. 
Example: if the song contains 2 drum tracks, it is necessary to enable it to read the corresponding 
SysEx message indicating to the midi device that track 9 or 11 is a drum kit. 
 
Send SysEx Messages before start 
Send a series of SysEx commands before the start of each song. Very useful for older expander 
who use non-standard instructions. 
 
Example: to send the GM reset, disable the "Send GS reset" option then paste the following string 
on "Send SysEx messages before start": 
F0 7E 7F 09 01 F7 
For the reset XG paste the following string: 
F0 43 10 4C 00 00 7E 00 F7 
It is possible to choose whether to address SysEx messages only to the main Midi device or to all 
devices. 
 
Flow optimization 
Optimize the data flow while playing the midi, it is recommended not to disable it. 
 
Hide info extra song sysex 
As description 
 
Sysex timing 
Set the delay time after sending a sysex message to the device. 
 
Allow multiple midi outputs 
It allows the use of multiple midi outputs when you want to manage multiple devices for the same 
song. 
Refer to the mixer in performance 
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Audio Options: 

 
 
On this screen you can set up to 4 audio outputs and the audio present in the video 
 
Audio Device OUT 1 – OUT 2 – OUT 3 – OUT 4 
It is possible to set a device for the output audio typically a sound card. 
And for each output we can decide whether to use it in stereo or mono (left or right) 
The Refresh key updates the list if you have just connected a new device. 
 
Audio Multi-Track vol 
Here the volume for multitrack songs is set 
 
Cut the initial silence 
If checked, it allows the execution of audio files starting directly from the first audible part. It is 
useful to check it if you want immediate execution even for audio tracks, especially CDGs that 
sometimes contain a silent part at the beginning that can last even more than 10 seconds. 
 
Fast loading 
Ability to load on the fly, even faster on audio files. 
The increase in speed is not very evident since Winlive is already very fast in a normal way. We 
recommend that you enable this option only if you really need to play the backing tracks in real-
time as it may reduce the quality of the transpose on some sound cards. 
 
Pre-Load Audio 
If checked, this option allows you to load the audio song into memory at the time of booking, so 
that when it is played the song starts faster. 
 
MultiTask preload 
If checked, this option allows you to speed up the loading of the songs. 
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Time change without distortion 
It allows the change of time without the song distorting. 
 
Compression of volumes 
Enable volume compression on audio, for details go to tools -> Winlive audio options. 
 
Enable Gain 
Enable the use of gain in the virtual mixer. 
 
Audio Buffer 
Set the buffer size. Increase this parameter in case of interruptions when playing audio and video 
files. It is recommended not to decrease from the default value. 
 
Do not change pitch for second track 
As per description 
 
FF Jump (seconds) 

These are the jumping seconds when FastForward fast forward is chosen on an Audio song,  
('F') key. 
 
Fade IN 
Set possible fade IN fixed for audio songs (time expressed in Milliseconds). 
 
Fade OUT 
Set possible fade OUT fixed for the audio songs (time expressed in Milliseconds).
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Karaoke and pictures: 

 
 
From this screen you can change the graphic theme of the program, the background image, 
customize the colours of the text and the background as well as the character of the Karaoke and 
more. 
 
Theme 
Allows you to select a graphic theme for Winlive. 
The theme affects the background and colour of the text, the fill and the shadows or effects. 
 
Use background image 
If checked, it matches by default the background image of the theme for all executions. 
 
Random images from a folder 
It is possible to select a folder from which Winlive loads images randomly and associates them 
with each song. 
 
Custom colours 
Allows customization of colours for text, fill and so on 
By extra line, we mean the extra lines following the running text 
 
Background colour 
In the absence of a background image, it is possible to change the background colour 
 
Font 
It is possible to establish a character common to all the text display modes 
 
Main Karaoke mode 
I come seven modes and parameters for displaying the text in the main monitor 
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It is also possible to improve the graphic quality of karaoke (not recommended for "slow" 
computers) 
 
Monitor background 
Allows you to customize the background of the main monitor and the Karaoke monitor. 
 
Monitor banner 
Allows you to insert a banner in the karaoke monitor 
 
Never hide monitor wallpaper 
As a description 
 
Display logo in the karaoke monitor 
In the absence of the tick, it does not display the WINLIVE logo in the middle of the Karaoke 
Monitor. In WINLIVE X logo in the upper right corner of the Karaoke monitor it is always displayed 
 
Viewing images or pdf files 
It is possible to decide where to display images or pdfs (scores or images) with various 
visualization possibilities 
 
Advance - Postponement text 
Possibility of anticipating or postponing for a selected number of Milliseconds the scrolling of the 
text according to the criteria of Midi File or Mp3. 
 
Singing start bar 
Possibility to display the start bar on the karaoke monitor and to move it. 
 
Bouncing Ball indicator 
Displays an animation on the line or syllable of the scrolling karaoke text. 
On the Midi Files, it changes colour according to the metronome. 
 
M-live encoding precedence (songservice) instead of Karaoke 
There are midi songs that can have more encodings for the text / chords, for example sysex format 
and tune 1000 format. 
 
Allow text sync and chords in wave files 
Ability to insert lyrics and chords in audio files 
 
Automatically optimize karaoke for mp3 
The mp3 text is optimized for a easily readable display 
 
Optimize midi karaoke 
The text in the midi files is optimized
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SongList:

 
 
SongList sort type 
It is possible to choose the sorting order for all the SongLists 
ID = insertion order, the last inserted will go to the end 
TITLE = by title, INTERPRETER = by interpreter, AUTHOR = by author, 
GENRE_NOTES = for the genre of the song or for the relative annotations 
TYPE = by type of song (e.g. midi, mp3, video, etc.) 
The sorting order of the SongList can be selected by combining different fields. 
You can use the Order field, which allows you to make a customized sorting of the lists as defined 
in the database. For a specific sorting for each SongList, refer to the SongList editor function in the 
instrument voice. 
 
SongList cells 
Allows you to set the size of the cells. Setting two cells per row gives you the largest dimensions 
for the cells. 
 
SongList columns 
Allows you to set the number of columns to be displayed in the SongList. 
 
Font size / SongList cell 
It allows you to set the font size within the cells of all the SongLists. 
 
Number of characters per cell 
It is used to set the maximum number of characters that each cell must have. 
 
SongList position 
You can view the SongList at the bottom, left or right side 
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Manage interpreter / author / time field etc. 
Interpreter to the right of the title 
It allows you to choose where to place the interpreter of a song. 
 
Typing in SongList 
It allows you to do a smart search, even writing only the first letters of the song.  
 
Grid style 
Allows you to adjust the border of the cells of all the SongLists. 
 
Text style 
Allows you to adjust the evidence of the text within the SongLists. 
 
SongList colours 
It allows the variation of the colours displayed within the SongList, assigning a different colour for 
each type of file, as well as for the background and selection. 
 
Highlight orphaned files in the SongList 
This important function identifies orphan files, i.e. files whose path does not match the one in the 
database. If the files are blackened, it means that they are unplayable.  
 
SongList font 
Allows the adjustment of characters within the SongList. 
 
SongList in Karaoke Monitor 
It also allows you to view the SongList on the second monitor. 
 
SongList in Karaoke Monitor 
View the SongList also in the Karaoke Monitor. 
 
Song done 
Colour all the songs already played. 
 
Pre-load the SongLists 
Pre-loading of the SongList by increasing the display speed of the same 
 
Do not hide SongList at the end of the song 
At the end of each song, the SongList remains active even if there is no "closed padlock" 
 
Report song with Karaoke / 'K' chords 
Signals the presence of the text or Chords through the letter K 
 
Use mouse wheel to scroll 
The mouse wheel is enabled to scroll through the songs of the SongList in performance
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Chords and Texts: 

 
 
Chords notation 
Allows you to leave the notation unchanged, or to convert all the chords that may be contained in 
the files in Italian format (Do-Re-Mi ..) or in Anglo-Saxon format (C-D-E ..) 
 
Exclude Bass Revolt 
If active, displays the Chords excluding the address, if any. 
Example: Gsus / C will be displayed as Gsus 
 
Transpose chords based on the transpose 
If active, the chord transposed follows the pitch change of the song (audio or midi). If deactivate, 
leave the chords unchanged when the pitch change is performed. 
 
Read Format CC # 1, GENERALMUSIC 
It allows the reading of chords in particular formats. By enabling this option, information next to 
the simple chords may be read in the chords field. 
  
Advanced CC # 1 chord scan 
It allows the reading of "advanced" of chords in CC # 1 format 
 
Fill and plain text 
It is possible to change the colour of the chords on the lyrics (Lectern with Chords mode), useful 
for differentiating the Karaoke text from the chords. 
 
Optimize the position of chords on the text where possible 
As per description 
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Chord Bar 
Allows you to set the height dimension of the chord bar. 
 
Sliding Chord Bar 
Allows the chord bar to slide along with the song. 
 
Number of cells in chord bar 
Allows you to choose the number of cells inside the chord bar 
 
Chords in the melody bar 
Allows chords to be inserted into the melody bar 
 
Colours of the chord bar 
Choice of colours for the chord bar 
 
Automatic chords (midi song) 
Ability to automatically calculate chords in midi files with various options 
 
View Txt and Rtf also in Karaoke Monitor 
If checked, it allows the text to be displayed even within the Karaoke Monitor 
 
TXT font 
Allows you to change the font, colour and size of the text beyond the background. 
It is also possible to center the TXT text and the RTF text 
 
Automatic text scrolling 
When associating a text (txt or rtf) with a file we can decide the scrolling speed of the text. 
Remember that you can use the K and L keys to move forward or backward in the text. 
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CDG / Video (Expert users only) 

 
 
It is good to interact with these parameters only if you are fully aware of the structure and 
characteristics of the Mp3 + CDG (Graphic Karaoke) files. 
 
CDG (expert users) 
Personal background on the CDG 
If enabled, use the current background colour instead of the original background colour in the 
CDG. 
 
Use board on the GDG 
Enable border colouring in the CDG where available. 
Disabling, by default, allows an improvement in the reproduction of CDGs on the computer that do 
not need a border like on a TV. 
 
Bias-Colour 
You can adjust the RGB colour gamut (Red, Green, Blue), higher values result in greater brightness 
for the respective colour gamut. 
 
VIDEO FILES 
Video Engine 
Select the video "engine" to read the files 
 
Audio Delay 
Establishes the audio delay compared to video. It is used when there is no perfect synchrony 
between video and audio 
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Video files only in the Karaoke monitor 
The video file will be loaded only in the Karaoke monitor, while in the main monitor there will be 
the text Karaoke. 
 
Do not use videos in the karaoke monitor 
Activating this function the video will not be displayed on the Karaoke monitor decreasing the 
video loading time. 
 
Maintain aspect ratio 
Keep the video size equal to the original size. 
 
Associated video in loop 
Associating a video file in this function will allow playback in the background continuously (loop) 
 
Text on the video 
It is not currently possible to display the text on a video but it can be positioned above or below 
the video, only in the karaoke monitor or on both monitors 
 
OPERATIONS ON THE OPTIONS 
 
• TO APPLY THE OPTIONS IT IS NECESSARY TO CLICK ON "APPLY" 
• TO EXIT THE SCREEN BY LEAVING THE MODIFICATIONS CLICK ON "CANCEL" 
 
With IMPORT you can import configuration options from one computer to another by exporting 
them with EXPORT 
With RESET the "factory" configurations are restored 
USE SETTINGS FOR MINIMUM REQUIREMENTS to set the minimum options compatible with less 
performing computers 
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Extra/Help 

SHORTCUTS 

Here is a list of keys (shortcuts) and related functions:  
 
(Windows) 
 
Spacebar    Opens the SongList or Pause / Play of the Song 
Arrow Keys    Opens the relevant SongList 
F1, F2, ..., F10    Opens the relevant SongList 
Shift + [F1 .. F10]   Opens the relative SongList 
Ctrl + [F1 .. F10]   Opens the relative SongList 
Shift + Ctrl + [1 .. 0]   Opens the relative SongList 
1..2..3 ........ 0   Play from the relevant Lessor or silent channel 
Shift + [1..0]    Book the relative Lessor 
Ctrl + [1..0]    Reserves the relative Marker of the booked Song 
Shift + Ctrl + [F1 .. F10]  Jumps to the relative Marker of the booked Song 
O     Play from the beginning of the song 
Q     Fade Out to the booked Song 
W     Change the size of the Karaoke text (small Med. Grd.) 
Shift + W    Change the text mode in the Main monitor 
Ctrl + W    Change the text mode in the karaoke monitor 
F     Next 
R     Back 
M     Melody (ch. 4) Yes / No [Song Midi] 
T     Restores the original Tempo [Song Midi] 
U     Solo Melody (Ch. 4) [Song Midi] 
N     Channels on / off as originally 
P     Talk Over (on key pressed) 
A     Activate all channels [Song Midi] 
K, L     Scroll for text in the lectern 
D     Drum only (Ch. 10) [Song Midi] 
C     Show / Hide chords 
Shift + C    Displays / Hides the Chords in the Karaoke Monitor 
Y     Mix with the booked Song 
Shift + Y    Manual Mixing (then press Y) of the booked song 
H     Scrolls through the mixing modes 
X     Opens the mixer 
I                   Opens the Mixer in Instruments mode (you can press the 1..0 and Q 

... Y keys for the On / Off tracks) 
V     Vocalist track (Ch. 16) Yes / No [Song Midi] 
B     Bass only (Ch. 2) and Drums (Ch. 10) [Song Midi] 
Enter    Send Play of the booked Song 
Pause     Pause / Play 
+     Increase by a semitone 
-     Decrease of a semitone 
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Pg. Up     Tempo increase [Song Midi] 
Pg. Down    Tempo decrease [Song Midi] 
Ctrl + +    Increase a Semitone of the booked song 
Ctrl + -    Decrement of a Semitone of the Booked song 
Ctrl + Pg. Up    Tempo increase of the booked song [Midi and Audio] 
Ctrl + Pg. Down   Tempo Decrement of the booked Song [Midi and Audio] 
Ctrl + M    Melody (Ch. 4) of the booked song Yes / No [Song Midi] 
End     Stop the booked song (STOP) 
Z     Fullscreen mode 
Backspace    Opens the song search window in the SongList 
Tab     Scrolls between occurrences of searches in the SongList 
S     Audio Sampler 
J     Pre Listening 
E    Show / Hide the Melody Bar 
Ctrl + Q / Ctrl + S   Virtual save current song 
Ctrl + K    Enable / Disable the Karaoke Monitor 
Ctrl + J    Enable / Disable the Clone Monitor 
,     Enable / Disable Drum Part Off midi drums 
.     Enable / Disable Drum Part Off midi percussion effects 
Shift + M    Enable / Disable any second associated track 
Shift + Pg. Up    Increase the Song Volume 
Shift + Pg. Down   Decreases the Song Volume 
Shift + [F11]    Open the whole database 
Home    Open Song List 
Del     Only if in loop Markers: Exit the loop 
Y     Only if it is Groove (midi or audio) does it exit the groove at the end 
 
Performance Display (With the SongList open): 
Home / Home   First column of the SongList 
End     Last column of the SongList 
Initial     Search for the first song with the initial 
Space     Book the Song and close the SongList 
Ins     Insert the Song into the Temporary Song List (F10) 
Pg. Up     First line of the SongList 
Pg. Down    Last line of the SongList 
Backspace    Search for a Song 
Tab     Repeat search 
Enter / Return  Play of the Song and close the SongList 
Esc     Close the SongList 
Del    Only in F10: delete from the F10 list 
 
Pre Listening 
Esc     Closes without saving 
F     Next 
R     Back 
G     It positions itself at the point set with J and pauses 
J     Set the position without closing the pre-listening 
H     Position test without closing pre-listening 
O     Start 
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ENTER     Closes by saving the Current position 
SPACE    Pre-listening pause / play area 
 
 
 
 
Audio Sampler 
\     Stop on all samplers 
S     Opens / closes and stops all samplers 
1..2..3 ..... 0    Play of the Sample 
CTRL + 1..2..3 ..... 0   Select the set 
 
Open search 
TAB    Search Song in the current SongList 
Shift + F11    Opens the entire database for research 
Ctrl + T    Filter by title 
Ctrl + I     Filter by interpreter 
Ctrl + G    Filter by Genre 
Ctrl + C    Filter by Artist / Composer 
Ctrl + D    Filter by ID 
Ctrl + B    Filter by Time or time range (from-to) 
Ctrl + A    All songs no filter 
Esc     Closes the search window 
 
In Database 
Ctrl + K    Enable / Disable the Karaoke Monitor 
ENTER    Send Play of the Song 
Esc     Stop of the Song 
E     Edit the database cell 
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(Mac Osx) 
Performance view (with the SongList closed): 
 
Spacebar    Opens the SongList or Pause / Play of the Song 
Arrow Keys    Opens the relevant SongList 
? + 2 digit number from 00 to 43 Opens the relative SongList (43 = the whole database) 
1..2..3 ........ 0    Play from the relevant Lessor or silent channel 
Shift + [1..0]    Book the relative Lessor 
Ctrl + [1..0]    Reserves the relative Marker of the booked Song 
Shift + Ctrl + [F1 .. F10]  Jumps to the relative Marker of the booked Song 
O     Play from the beginning of the song 
Q     Fade Out to the booked Song 
W     Change the size of the Karaoke text (small Med. Grd.) 
Shift + W    Change the text mode in the Main monitor 
Ctrl + W    Change the text mode in the karaoke monitor 
F     Next 
R     Back 
M     Melody (ch. 4) Yes / No [Song Midi] 
T     Restores the original Tempo [Song Midi] 
U     Solo Melody (Ch. 4) [Song Midi] 
N     Channels on / off as originally 
P     Talk Over (on key pressed) 
A     Activate all channels [Song Midi] 
K, L     Scroll for text in the lectern 
D     Drum only (Ch. 10) [Song Midi] 
C     Show / Hide chords 
Shift + C    Displays / Hides the Chords in the Karaoke Monitor 
Y     Mix with the booked Song 
Shift + Y    Manual Mixing (then press Y) of the booked song 
H     Scrolls through the mixing modes 
X     Opens the mixer 
I                   Opens the Mixer in Instruments mode (you can press the 1..0 and Q 

... Y keys for the On / Off tracks) 
V     Vocalist track (Ch. 16) Yes / No [Song Midi] 
B     Bass only (Ch. 2) and Drums (Ch. 10) [Song Midi] 
Enter    Send Play of the booked Song 
Pause     Pause / Play 
+     Increase by a semitone 
-     Decrease of a semitone 

Pg. Up     Tempo increase [Song Midi] 
Pg. Down    Tempo decrease [Song Midi] 
Ctrl + +    Increase a Semitone of the booked song 
Ctrl + -    Decrement of a Semitone of the Booked song 
Ctrl + Pg. Up    Tempo increase of the booked song [Midi and Audio] 
Ctrl + Pg. Down   Tempo Decrement of the booked Song [Midi and Audio] 
Ctrl + M    Melody (Ch. 4) of the booked song Yes / No [Song Midi] 
End     Stop the booked song (STOP) 
Z     Fullscreen mode 
Backspace    Opens the song search window in the SongList 



 88

Tab     Scrolls between occurrences of searches in the SongList 
S     Audio Sampler 
J     Pre Listening 
E    Show / Hide the Melody Bar 
Ctrl + Q / Ctrl + S   Virtual save current song 
Ctrl + K    Enable / Disable the Karaoke Monitor 
Ctrl + J    Enable / Disable the Clone Monitor 
,     Enable / Disable Drum Part Off midi drums 
.     Enable / Disable Drum Part Off midi percussion effects 
Shift + M    Enable / Disable any second associated track 
Shift + Pg. Up    Increase the Song Volume 
Shift + Pg. Down   Decreases the Song Volume 
Shift + [F11]    Open the whole database 
Home    Open Song List 
Del     Only if in loop Markers: Exit the loop 
Y     Only if it is Groove (midi or audio) does it exit the groove at the end 
 

 
 

Performance Display (With the SongList open): 
Home / Home   First column of the SongList 
End     Last column of the SongList 
Initial     Search for the first song with the initial 
Space     Book the Song and close the SongList 
Ins     Insert the Song into the Temporary Song List (F10) 
Pg. Up     First line of the SongList 
Pg. Down    Last line of the SongList 
Backspace    Search for a Song 
Tab     Repeat search 
Enter / Return  Play of the Song and close the SongList 
Esc     Close the SongList 
Del    Only in F10: delete from the F10 list 
 

 
Pre Listening 
Esc     Closes without saving 
F     Next 
R     Back 
G     It positions itself at the point set with J and pauses 
J     Set the position without closing the pre-listening 
H     Position test without closing pre-listening 
O     Start 
ENTER     Closes by saving the Current position 
SPACE    Pre-listening pause / play area 
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Audio Sampler 
\     Stop on all samplers 
S     Opens / closes and stops all samplers 
1..2..3 ..... 0    Play of the Sample 
CTRL + 1..2..3 ..... 0   Select the set 
 
Open search 
TAB    Search Song in the current SongList 
Shift + F11    Opens the entire database for research 
Ctrl + T    Filter by title 
Ctrl + I     Filter by interpreter 
Ctrl + G    Filter by Genre 
Ctrl + C    Filter by Artist / Composer 
Ctrl + D    Filter by ID 
Ctrl + B    Filter by Time or time range (from-to) 
Ctrl + A    All songs no filter 
Esc     Closes the search window 
 
In Database 
Ctrl + K    Enable / Disable the Karaoke Monitor 
ENER    Send Play of the Song 
Esc     Stop of the Song 
E     Edit the database cell 

 

Tips: 
1) Winlive is structured to manage many functions while performing in a show or concert, through 
the exclusive use of the computer keyboard thus avoiding the inconvenience of having to manage 
the functions with the use of the mouse, which implies longer time. 
2) It is advisable to keep a printout of the hot keys on hand, generally after a couple of 
performances in order to memorize the keys and managing the program in a more immediate 
way. 
 
VIDEO TUTORIAL 
We can connect with the latest video tutorial available on Youtube 
 
MOBILE SOFTWARE (iOS/Android) 
List of APPs for smartphones and tablets produced by Promusicsoftware. They are available for 
both iOS and Android 
 
WINLIVE ON FACEBOOK 
The official Facebook page of Promusicsoftware 
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Demo Songs 

DEMO SONGS 
A songlist with various demo backing tracks 
 
BACKING TRACKS 
Links to major backing track producers 
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Remote Support 

This technical support allows you to connect directly ONLINE with Promusicsoftware technicians 
for any info about some functions 
This support is highly appreciated by all users of the PRO versions in fact by purchasing or 
upgrading to Winlive Pro / Pro Synth 11 you are entitled to 120 minutes of free remote assistance 
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ADDENDUM 

Specifications and compatibility 

Funzione Caratteristica 

File compatibility: 
midi, kar, mp3, wav, wmt, cdg, cdg-zip, avi, mpg, mp4, flv, 
wma, lrc, txt, rtf, jpg, gif, bmp, ytb YouTube, pdf 

Midi format compatibility: Tipo 0, Tipo1, Smf 16 tracce 

Lyrics compatibility: 
Tune1000, M-live, Solton, TextInKar, MP3TagV2, MP3 M-
liveText 

Reset mode: GS, ensures full compatibility with most midi songs 

Maximum number of songs in the list: 120.000 

Maximum song number in database:  > 200.000 

Average song access time: 0.05 - 0.2 sec. calculated on 2Gzh, 2GB ram 

Number of pre-set sounds: 344 Instruments * + 32 DrumKit * + 32 User Sounds 

 

The midi engine has been redesigned from scratch compared to all previous versions of Winlive, 
therefore slight differences in reproduction may be noticed. 

Now the management of the midi takes place totally in MultiTasking, an independent process 
whereby it is now possible to open windows and programs while working on it, reducing Winlive 
to an icon even during the execution of a Midi File, without incurring in slowdowns. 

* There are a lot of usable midi sounds but, by convention, only the name of the first bank 
displayed on the program (e.g. for Hard FM Piano bank024-pc: 006 the name ELECTRIC PIANO 2 
bank will be displayed: 000- pc006). If the device is enabled to reproduce this sound, it will use the 
correct sound.
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LEGAL NOTICES 

Winlive Pro user license 
 
READ THIS DOCUMENT CAREFULLY BEFORE INSTALLING THE PROGRAM. 
THE PROGRAM INCLUDED IN THIS DISC IS LICENSED TO THE USER. YOU AGREE TO COMPLY WITH THE 
TERMS OF THIS LICENSE OF USE. WARNING: THIS PROGRAM IS PROTECTED BY COPYRIGHT LAWS AND 
INTERNATIONAL TREATIES. THE SOFTWARE PRODUCT IS LICENSED, IT IS NOT SOLD. UNAUTHORIZED 
REPRODUCTION OR DISTRIBUTION OF THIS PROGRAM, OR PART OF ITS, MAY RESULT IN SEVERE CRIMINAL 
AND CIVIL PENALTIES. 
 
1 - User rights 
PRO MUSIC SOFTWARE grants the end user the right to use a copy of the attached Software program on a 
single computer. The Software is intended "in use" on a computer when it is loaded on the temporary 
memory (RAM) or installed on the permanent memory (eg hard disk, CDROM or other storage medium) of 
that computer. 
 
2 - Copyright 
The software is owned by the PRO MUSIC SOFTWARE and is protected by copyright laws in force in Italy; by 
international provisions and treaties and by all other applicable national laws. In any case, the user cannot 
reproduce the manual or part of it and the written material accompanying the Software. 
 
3 - Warranty limits 
PRO MUSIC SOFTWARE warrants that the Software will function in substantial compliance with the manual. 
To protect the user, it will be possible to use a maximum of 3 activations in total. We remind you that even 
in case of formatting a new activation will have to be used. For further activations please contact 
Promusicsoftware 
 
4 - Limits of liability 
In no case can PRO MUSIC SOFTWARE be held liable for damages (including without limitation: damage due 
to loss or loss of earnings, business interruption, loss of information, penalties or other economic losses) 
deriving from the use or inability to do use of the Software, even if the PRO MUSIC SOFTWARE has been 
warned of the possibility of such damages. 
 
5 - Installation 
Winlive Pro uses a self-installing installation package. 
At the time of installation, it will be possible to choose the installation path and other parameters. Note 
that registry entries and system settings may be changed to allow the correct functioning of the program 
itself. 
 
6 - Other restrictions 
The Setup in this Pro version is redistributable as it is. It is forbidden to reproduce even partial and the 
partial distribution of the individual files generated by the Setup. 120 minutes of FREE REMOTE ASSISTANCE 
and YOUTUBE SERVICE until February 2022 are guaranteed.
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Made by ProMusicSoftware 

 
www.promusicsoftware.com 
info@promusicsoftware.com 

PROMUSICSOFTWARE -  Bisceglie (BT) - Italy 

 
This guide generally follows the version of Winlive Pro / Pro Synth 11, we are not responsible for 
any omissions or inconsistencies as micro-updates released frequently may vary product 
specifications. 

 


